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Message from the President
By Wesley Thomas Hughes, RDR, CRR, FPR
2007-2008 President

Ever Wonder
What Your
FCRA Board is Up To?
Greetings. I hope everyone is well and prospering in
2008. I know that sometimes the general membership
wonders what the FCRA Board does during the time
when we are not at our seminars and conventions.
Since my last Presidential message, I want to fill you
in on what has been happening at the FCRA Board
level and inform you of some events that have occurred or are planned for around the state.
On February 2nd, NCRA sponsored a seminar in
Jacksonville entitled “Train the Trainer.” Laura Dennis
of L. Dennis & Associates, Washington, DC, and Nate
Smith of NCRA were the presenters. Louise Pomar
and I were in attendance on behalf of FCRA as well
as Past Presidents Cathy Philips and Paulita Kundid.
There were approximately 100 attendees total from
Florida, Georgia, and Alabama. The purpose of this
seminar was to teach us how to market ourselves in
the ever-changing market of court reporting, regardless of your chosen method of reporting. Everyone I
talked to after the seminar thought it was an excellent program. I asked Laura and Nate to please try
to have another one in Florida so that more reporters
can attend. Watch for it!
Not very long after the Jacksonville seminar, FCRA
was contacted by an attorney working with several
of the Florida Bar rules committees. They are looking
at consolidating and conforming the rules across the
board relating to reporters and the making of the
record and to clean up the many inconsistencies
they have observed and see where things might be
simplified. They are also taking a look at certification, or at least clear, standardized definitions and
qualifications of reporting for all methods to be used
as a statewide model. Each circuit now is basically
defining “qualified,” “certified,” and the standards
in their own way, and even a cursory survey of at
least half of the circuits in Florida indicate that the
definitions and qualifications run the gamut. The Bar
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representative has asked for FCRA’s input and assistance, and I have formed a task force to liaison
with their representative, provide the information
they request, and to monitor all events concerning
this issue. The committees will be meeting at the
Florida Bar Convention in June, and FCRA will have
representatives from the task force in attendance. I
find this encouraging that someone other than the
reporters feel we should have certification in the
State of Florida. We will know more about this at our
Mid-Year Conference.
At the end of February, we held our Board meeting
in Fort Lauderdale at the offices of U.S. Legal. I would
like to thank U.S. Legal and Jennifer Gaul, PresidentElect, for accommodating us with such great service
during our meeting. Of course, the minutes will be
available for you to read at the Business Meeting in
Sarasota.
FCRA is planning to have a membership exchange
in the Tampa/St. Pete area on Thursday, May 8th,
from 6 p.m. to 8 p.m. It will be held at the Centres
at Feather Sound, 3001 Executive Drive, Suite 130,
Clearwater, FL. Donna Kanabay and Ginny Hyland
have been hard at work putting this together. From
what I’ve seen of their plans, it should be a great
exchange, including door prizes. After the Tampa/
St. Pete exchange, our next planned one is to be
held in South Florida.
As I am sure you are aware, our next conference
will be held in Sarasota June 27-29. I know that Gayl
Hardeman and Ginny Hyland have really worked
hard to provide a conference that everyone will
enjoy and learn from. I look forward to seeing all
of you in Sarasota.
Well, that brings us up to date with what has been
happening with the FCRA Board. Until next time,
remember our 2008 motto, “BE THE BEST YOU CAN
BE.”
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Editor’s Notes
By Louise Pomar, RPR, FPR, CERT*D, FCR Online Editor

Taking Your
Show on the Road
On Saturday, February 2, 2008, I spent my day in Jacksonville attending the “Marketing Court Reporter Value
– Train the Trainer” seminar put on by the National Court
Reporters Association. What an informative, valuable
and motivating day that was!
In case any of you missed the e-mail that was sent
out by NCRA informing its members of the upcoming
seminar, or the date conflicted with something that was
equally as important in your life, or you just plain chose
not to attend, I am here to tell you that you really missed
out on this one. The information shared with attendees,
the interactive exercises and role-playing scenarios really added pizzazz to this one-day seminar.
Don’t despair, however. All is not lost! The next seminar
is slated for July 26, 2008, at NCRA’s Annual Convention
and Exposition in Anaheim, California. Other road trips
that the seminar presenters have taken are to Cincinnati, Phoenix, Seattle and Denver, with more seminars
in the works.
Laura Dennis, formerly Senior Government Relations
Specialist and PAC Manager with NCRA, now president
of L. Dennis & Associates, Inc., along with Nate Smith,
NCRA’s ER Task Force Staff Liaison, and Paulita Kundid,
RPR, FPR, CLVS, Chair of NCRA’s ER Task Force, joined
hands and put forth this dynamic presentation. Our very
own distinguished FCRA President Thomas Hughes was
also present and addressed the audience as well.
The goal of the seminar is clear just by its name: Marketing Court Reporter Value. We court reporters have
learned to be the silent one in the courtroom, only
speaking up when necessary to ask someone to slow
down, speak up, or to clarify the spoken word. Could
that be why we are all too silent when it comes to
marketing how valuable our service really is? Or is
it because our method of court reporting has been
around for so long that we thought the end-users and
decision-makers knew, without question, how valuable
our product is and the myriad of services we offer?
Whatever the reason, it is vital now more than ever that
we all stand up individually and collectively and step
out of our comfort zones to spread the word about our
profession’s value and its human element.

The seminar opened with Ms. Kundid sharing interesting
facts about the court reporting marketplace today. Did
you know, for instance, that NCRA experienced a 40%
increase in calls regarding Electronic Recording in 2005
compared to 2004? Or that in response to an NCRA ER
inventory nationwide, of the counties that responded
almost 85% utilized ER in their courts of record?
Next we participated in several exercises that put our
brains into gear. The first involved writing down three
examples of what we, as individuals, felt gave us an
edge over electronic court reporting. The ability to
provide continuity of operations when power outages
occur using our state-of-the-art equipment, discerning a confidential attorney/client exchange and not
reporting the exchange on the record, and providing
instant voice-to-text translation for judges, attorneys,
and/or witnesses who are deaf or hard of hearing are
but a few examples that I noted.
Defining court reporter value was exercise number
two. The exercise was performed as a group with the
individuals at our tables. It was obvious that every single
one of us knew our value by the number of points we
listed: providers of the only voice-to-text translation currently out on the market, managers of a multi-purpose
system that gathers and stores data for all legal professionals, preparers of accurate not adequate transcripts,
to name a few. One thing that we tend to take for
granted, though, is that everyone else knows what value
we bring to the table. Not true! We must identify the
end-users and decision-makers in our circuit, be it the
court administrator, the chief judge, board of county
commissioners or otherwise, and educate them as to
our value.
Exercise number three was a marketing listening exercise. Did you know that “marketing listening” is different
from “hearing,” and it is also different from what we
employ in our profession? First, we must know to whom
we are marketing and what benefits our service will provide them. We must listen for the main ideas presented
by the speaker, giving them our full attention. We must
Continued on page 7
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Association Bulletin Board

Advertising Special

$ $ $
Contract to advertise in 8 issues (2
years) of this magazine and get a
special 15% discount on top of our
low rates! Call FCRA Headquarters
today at 407-774-7880.

MARK YOUR CALENDAR!
FCRA Annual Convention
October 17-19, 2008
Ocala Hilton,
Ocala, Florida

Order Your Florida Manual
Stay up to date on Florida Rules
and Procedures. Call FCRA Headquarters at 407-774-7880 to order your newly revised Florida
Manual.
Just $35.00!

FLORIDA MANUAL UPDATES!
NOW AVAILABLE ON CD!!!
Call FCRA Headquarters
at 407-774-7880.

FCRA I N
T
BU LLERD
BOA
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Needful People
Need a job? Need a
reporter? Contact Placement Chairman Sandi
Nargiz at 850-878-2221 or
fax: 850-878-2254 or email:
snargiz@comcast.net

Address Changes
ADDRESS CHANGED?
PHONE NUMBER CHANGED?
Fax your changes to Headquarters at 407-774-6440 as soon as
possible!

WANTED!
Your stories to share with other
reporters. Submit an article and
receive .15 CEU points if
published in FCR Online. Email
your story to lbp1958@aol.com

GET YOUR MEMBERSHIP
DIRECTORY ON DISK!
FCRA now offers the Membership Directory on a CD for only
$10! Contact FCRA Headquarters
for more information at 407-7747880.

Stenograph Special

Watch the FCRA Website
for Updates!
www.fcraonline.org

WEB SITE SPONSORS
WANTED
Call Rick
Greenspan at
954-340-2557 for
details.

$ $ $
Get last line pricing with Stenograph supplies as a member
of FCRA and FCRA receives a
rebate.

DON’T MISS E-FLASHES!
Be sure your email address is current.
Call FCRA Headquarters and give
them your email address today (407774-7880) or email your changes to
bking@kmgnet.com (use FCRA in the
subject line).

ARE YOU MOVING? CHANGING A PHONE NUMBER?
CHANGING A FAX NUMBER? CHANGING OR
GETTING AN EMAIL ADDRESS?
If so, let FCRA Headquarters know right away. Simply fax 407-774-6440
today to make any necessary changes to the information we have
on file for you!
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Editor’s Notes

Taking Your Show
FCR Online
Contributing Editors on the Road
Susan D. Wasilewski, RPR,
CRR, CCP, CMRS, FPR
Ginny Hyland, RPR, FPR
Gayl Hardeman, FDR, CCP, CRR, RPR, FPR
Sandy Narup, RPR, FPR
Donna M. Kanabay Harvey, RMR, CRR, FPR

FCR Online
Deadline Dates
(Fall) Aug/Sept/Oct............................. July 5, 2008
Publication Date................................ Aug. 12, 2008

(Winter) Nov/Dec/Jan.........................Oct. 5, 2008
Publication Date................................ Nov. 12, 2008

(Spring) Feb/Mar/Apr.......................... Jan. 5, 2009
Publication Date.................................Feb. 12, 2009

Continued from page 5
not assume what they are going to say next. We must
let them finish before we begin to talk, avoid emotional
involvement, and ask questions and provide feedback.
As professionals and advocates for our profession, that
should not be a hard task to master.
The final and my most favorite exercise was role playing.
This was very similar to the role playing that I participated in at NCRA’s Boot Camp several years ago as an
FCRA Board member. We met in groups with a mock
judge (Cathy Phillips, past FCRA President), mock court
administrator (Karen Yates, NCRA President-Elect), mock
legislator (Laura Dennis), mock law firm owner (Nate
Smith), and a mock ER vendor (Paulita Kundid).
We were given a total of twenty minutes for each meeting; five minutes to prepare, ten minutes to converse,
and five minutes to debrief. Our task was to inform the
representatives we were meeting with who we were,
why we were there, and what values our services would
be to them. This exercise afforded all of us the opportunity to put into play what we had learned from the
day’s seminar: how to market court reporter value. And
believe me, some of the representatives were ruthless
and made it very challenging for us to stay focused
and on point, keep emotional involvement at bay, and
not get defensive in our presentations to them. It was a
wonderful exercise to help prepare all of us for almost
any type of personality or perceived obstacles that we
may come across in the marketplace.
One of the most important messages that I took away
from the seminar was to educate and promote my
value and place within the legal system, but to do so
in a cooperative and effective manner. Budget cuts,
court reporter shortages, and negative publicity about
our profession have all played a role in where we are
as a profession today. So while it is imperative that we
cooperate with the end-users and decision-makers
once a decision has been reached, we should do
everything in our power to educate them in advance
of making that decision.
So, will I see YOU on the road?

(Summer) May/June/July.................. April 5, 2009
Publication Date.................................May 12, 2009

May/June/July 2008 • FCR Online

7

On the National Scene

On the National Scene…
Court Reporting Designated One of the Fastest Growing
Professions by Federal Government, Although Number
of Graduates is Trending Downward
Reprinted from the National Court Reporters Association Website
WASHINGTON, D.C. (April 1, 2008) – For the first time
ever, employment prospects in the court reporting
profession have been projected by the federal
government to grow “much faster than average,”
reflecting “excellent” job opportunities “as job
openings continue to outnumber jobseekers,” the
National Court Reporters Association (NCRA) said
today.
Ironically, the government’s estimate comes at a
time when NCRA said the number of schools taking
part in its certification programs and their graduates
have steadily declined over the decade. Almost
1,000 students graduated from more than 100 NCRAcertified schools in 1996. Ten years later, NCRA said
only 62 certified programs across the U.S. graduated
fewer than 360 court reporters.
The “Occupational Outlook Handbook 2008-2009,”
recently released by the federal Bureau of Labor
Statistics (BLS), said court reporter employment
will grow by 25 percent through 2016, because of
“increasing numbers of civil and criminal cases”
coupled with federal telecommunications legislation
that requires television captioning and the increasing
demand for real-time communication access for
people who are deaf and hard of hearing under
the American with Disabilities Act.
In recent speeches, U.S. Labor Secretary Elaine Chao
said with the country transitioning to a knowledgebased economy, workers with higher skills “are
being paid a premium,” while she said the strongest
demand is for workers “in technical occupations.”
Her words are borne out by the BLS projection for
court reporting and by a 2006 NCRA survey that
determined an average net income after expenses
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of $65,242 for freelance (deposition) reporters and
$72,072 for court reporters who work for local, state
or federal courts and agencies.
“Our efforts to increase the number of court
reporters and training opportunities are beginning
to pay off,” says Mark Golden, CAE, NCRA’s
executive director. “Last year, nine new schools
opened to teach court reporting, while maintaining
high performance standards and a challenging
academic curriculum. Yet we still have a long way
to go before the supply even starts to meet the
demand.”
Golden noted that the training is challenging. “It
demands a great deal of practice to develop skills
of dexterity and concentration,” he says, “but for
those who become guardians of the record and
providers of communication access, the rewards
and sense of making a real contribution make it all
worthwhile.”
To further meet the future need for court reporters,
NCRA is reaching out to potential students at http://
www.bestfuture.com/. In addition, legislation now
before Congress calls for competitive grants to train
captioners and reporters who specialize in realtime
and Communication Access Realtime Translation.
CART provides an immediate translation of all spoken
words and environmental sounds in academic,
civic, religious or cultural events for people who are
deaf, have hearing loss or are learning English as a
second language.
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On the National Scene

CALLING ALL REPORTERS!

Honor a Veteran by Interviewing Him/Her
for the Veterans History Project
Please join your colleagues who have interviewed many of our nation’s wartime veterans for the Veterans History Project (VHP).
America’s World War II veterans are dying at a rate of 1,700 a day,
which is why it is critically important that we get as many of these
stories as possible. Of course we want the oral histories of veterans
who served in all of our nation’s wars and conflicts, including our
current Iraq and Afghanistan veterans.
Court reporters play a vital role in making sure that these wartime
memories are preserved. Not only will you be collecting information
that will be used by researchers, authors and academics, but you
will be honoring America’s veterans.
Most of us have a family member, friend or colleague who has served
our country during a period of war. If you are interested in interviewing a veteran, please contact Beth Kilker, VHP Coordinator, National
Court Reporters Foundation, at bkilker@ncrfhq.org, or at 800-2726272, ext. 174, to request a Veterans History Project Field Kit.

Upcoming Events Calendar 2008
May 8

West Coast Membership Exchange Meeting
Centres at Feather Sound, 3001 Executive Drive, Suite 130, Clearwater, FL • 6 p.m. to 8 p.m.
RSVP by Friday, May 2 to Donna Kanabay, donna@kanabay.com or 813-545-0645

June 16 - 28

NCRA Written Knowledge Tests
Contact NCRA Testing Office, 800-272-6272 testing@ncrahq.org or www.ncraonline.org/testing

June 22 - 24

AAERT 15th Annual Conference, San Antonio, Texas
http://www.aaert.org

June 27

Florida Professional Reporter Seminar & Certification Test. Hyatt, Sarasota
www.FCRAonline.org

June 27 – 29

FCRA Mid-Year Conference, Hyatt, Sarasota
FCRA Headquarters 407-774-7880, www.FCRAonline.org

July 24 - 27

NCRA Annual Convention and Exposition, Anaheim, California
Contact Marilyn Dent, mdent@ncrahq.org http://ncraonline.org/Events/Annual/

July 26

Marketing Court Reporter Value – Train the Trainer Seminar
NCRA 2008 Annual Convention and Exposition, Anaheim, California
http://ncraonline.org/Events/Annual/

Oct. 17 - 19

FCRA Annual Convention, Ocala Hilton
Information to be posted on the FCRA website www.FCRAonline.org

Please notify Louise Pomar, Editor, lbp1958@aol.com, of any upcoming events that you would like to appear
in the “Upcoming Events Calendar.”
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On the State Scene
Reprinted from the April 1, 2008, edition of The Florida Bar News

Courts Foresee Staff Reductions

30 Percent of the Workforce is at Risk
By Gary Blankenship, Senior Editor
Asking the Florida court system to
cut its budget by 10 percent next
year — on top of 6 percent cuts this
year — would be asking the third
branch of government to commit
suicide, Supreme Court Chief Justice Fred Lewis told a key Senate
committee.
“I don’t believe any of you wish
to undermine an entire branch of
government,” Lewis told the Senate
Criminal and Civil Justice Appropriations Committee March 20. “I plead
with you to work with us to find other
ways to address this problem other
than a 10 percent across-the-board
cut.”
That 10 percent reduction, the chief
justice said, “is placing an arrow
through the heart of the branch. I
can tell you the soul of the branch
will remain strong and we will continue to strive to serve the people of
Florida. But now with the 10 percent,
if we come forward and say we can
sustain the 10 percent, then we’re
saying we’ll commit suicide.”
Lewis made his pitch, and then
representatives from state attorneys, public defenders, guardians
ad litem, the offices of capital collateral regional counsel, and other
court and law enforcement related
agencies told the committee how
they would cope with a further 10
percent budget reduction for the
2008-09 fiscal year on top of already
deep cuts for the current year.
There was a glimmer of hope given
by the committee members. Chair
Victor Crist, R-Tampa, said the panel
had no choice within its budget
allotment but to cut 10 percent
across the board from the courts
and the state agencies it oversees.
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But he noted that the committee’s
budget could be amended once it
goes to the Senate floor and would
likely be changed again during
budget negotiations with the House.
Some committee members said
they would try to take funds from
other state programs to lessen the
impact on the courts.
“Some things are more important
than others. I think we should all
keep in mind that on the floor we
can find more sources of money,”
said Sen. Alex Villalobos, R-Miami.
“There’s no way that I would be
able to live with myself if I didn’t
fight to preserve the judiciary at the
level where it would be effective for
the people of the state of Florida,”
said Sen. Arthenia Joyner, D-Tampa.
“I have no problems with raiding
someone else’s budget to save a
branch of government.”
Added Sen. Charles Dean, R-Inverness: “If I’ve got to make a
choice between spending hundreds
of millions of dollars to protect a frog
or a gator and funding the courts
. . . the frog has got to find a new
pond.”
Those appearing before the committee presented a bleak picture
of the impact of the proposed 10
percent budget cuts, which came
on top of two budget reductions
imposed for the 2007-08 budget
year (the second approved only the
week before).
Lewis told the committee that in the
first round of cuts last September,
the courts lost more than $9 million,
and in the cuts approved March 12,
another $17.2 million was sliced. The

only way furloughs were avoided
with the latter cut was by shuffling
the court’s trust funds and finding
an additional $2.1 million. Cutting
20 percent would cost the courts an
additional $41.2 million, he said.
The cuts for the current year required
a work force reduction of more
than 240 positions (met by not filling
existing positions), Lewis said. The
10 percent cut would require laying off another 727 employees — a
total loss of 967 positions in about
a year, or a total of 30 percent of
the judicial system’s work force.
He noted the court system added
about 1,200 employees under Revision 7 when the state assumed many
functions that had been funded by
counties.
Cuts that deep, Lewis said, would
set the courts back 30 years.
He explained that 87 percent of
the court budget is in salaries and,
of that, 42 percent is for judges,
who are constitutional officers and
hence cannot be fired or have their
salaries reduced. The cuts have to
be concentrated on support staff,
where the impact is, in effect, an 18
percent reduction, he said.
The impact on the courts would
be incalculable, with delays for all
types of cases, including high priority criminal and family proceedings
that have statutory time limits, Lewis
said.
Court mediation programs, which
have dramatically reduced the
number of trials, will be ended,
which “would result in delays and
higher costs for citizens,” Lewis
said.
Continued on page 11
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Courts Foresee Staff Reductions - 30 Percent
of the Workforce is at Risk

Continued from page 10
Children in foster care, landlords
looking to evict tenants, and foreclosure actions would all be delayed,
Lewis said, warning it’s even possible
those charged with crimes might go
free because the courts couldn’t
meet speedy trial deadlines.
Lewis pledged to work with legislators to find additional revenues for
adequate sources of funds. “We
must get through these troubled
waters without sacrificing a branch
of government,” he said.
Other court-related agencies projected similar woes, but Crist repeated his message that budgets
will be tight.
To state attorneys, Crist said, “You
guys are going to have to do a
better job of who you choose to
prosecute.
“With the public defenders, you
need to do a better job with those
you provide service and determine
if they truly meet the indigent standards.”

ployment of prosecutors, investigators, and staff. I am not telling you
that for any shock value,” he said.
“To do this would compromise public safety in the state of Florida.”
Work loads for felony prosecutors
would rise from 350 to 650 cases,
he predicted, and lesser experienced prosecutors
would have to take on
more complex cases.
Fourth Circuit Public
Defender Bill White,
representing the
Florida Public Defender Association,
said PDs may have
trouble meeting all
of their constitutional functions with
another 10 percent
budget reduction.

Other
court-related
agencies
projected similar
woes, but Crist
repeated his
message that
budgets will be
tight.

Thirteenth Circuit State Attorney
Mark Ober, president of the Florida
Prosecuting Attorneys Association,
said to meet the reductions of the
current budget year, state attorneys
have not filled 493 positions, both for
prosecutors and support staff.

“When you’re looking at whether the
lights are going to
get turned out or the
water turned off, well
you can probably
get some candles
for light,” White said.
“What we’re talking
about is turning off the
water taps with these
10 percent cuts. . . .

“We did that out of respect for this
legislature and because we wanted
to be part of the solution,” Ober
said. “That was done even though
we are struggling more than ever.”

“If you’re jamming the whole system up with more cases and fewer people to do the job, then
the quality of what we present to the judges goes down.”

But an additional 10 percent budget
cut will mean laying off another 536
employees, he said. Combined with
unfilled positions, that would be a 17
percent reduction for prosecutors.

Public defenders may have to
stop representing defendants in
misdemeanor cases, although
one option would be for the legislature to specify that no jail time
would result from such a conviction,
in which case public defenders
would not be required, White said.

“We would painfully and regretfully
be compelled to terminate the em-
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Angela Orkin, who runs the state’s
Guardian ad Litem Program, said to
comply with budget cuts this year,
43 employees had to be laid off,
which resulted in 2,000 children not
having guardians ad litem. To meet
the 10 percent reduction, she said,
more staff would have to be let go,
and another 2,300 children would

not be represented. That would
reverse the trend of the past four
years where the state increased
the percentage of children in court
cases with guardians ad litem
from 50 to more than 80 percent.
Bill Jennings, the capital collateral
regional counsel for the middle region of Florida, said the committee’s
requested cuts would mean the
loss of 10 positions for the middle
Continued on page 12
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Courts Foresee Staff Reductions - 30 Percent
of the Workforce is at Risk

Continued from page 11
and southern regional counsels.
That in turn, he said, would reduce
the ability of those offices to appeal in the federal court system.
The hearing before the Criminal
and Civil Justice Appropriations
Committee came only eight days
after the legislature approved
cuts for the 2007-08 fiscal year
that diminished the budgets for
the courts, public defenders, and
state attorneys by millions of dollars.
The latest 2007-08 fiscal year cuts for
the courts and state attorneys were
expected to be painful, but not
cause the layoff of any employees.
Several public defenders initially said
they would have to furlough employees for a few to several days before the fiscal year ends June 30, but
sharing funds among various circuits
addressed that problem — for now.
“The future is going to be bleak for all
of us,” said Eighth Circuit Public Defender Richard Parker, president of the
Florida Public Defender Association.
State Courts Administrator Lisa Goodner said details on how the courts
could meet the $17.2 million in cuts
for the current year were basically
unchanged from earlier plans. (See
story in the March 15 Bar News.) That
involved taking monies from various
trust funds plus another $2.1 million in
nonrecurring revenues for the courts.
That avoided what was feared to be
furloughs of court employees before
the June 30 end of the fiscal year.
As it did for state attorneys and the
courts, the legislature gave the public defenders permission to shift trust
funds to meet their salary needs,
and even move trust funds among
various circuits. But the FPDA’s Parker
said that wasn’t nearly enough.
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As the legislature prepared to vote
on its budget cuts on March 12,
Parker said nine public defenders
didn’t have enough money for the
year and might have to furlough
employees before the end of June.
That was down from 13 a week
or so earlier before the circuits
began juggling trust funds and
those with surpluses sharing with
those who didn’t have enough.
Parker said the defenders were
about $2 million short of what would
be needed to avoid furloughs.
He later said, at a subsequent
conference among defenders,
enough money was found to avoid
all layoffs. For example, his office’s
$200,000 deficit was made up by surplus funds transferred from 13th Circuit Public Defender Julianne Holt.
All of the money transferred among
public defender offices is coming
from trust funds, Parker said, as no
office has any extra general funds.
In some cases, the sources of those
trust funds could be local, such as
a county which contributed money
for technology or to defend those
charged with violating local ordinances, but the money now might
be sent to another circuit for salaries.
Even though the furloughs were
avoided, “at the end of this budget year, we will have exhausted
every dime in the association,”
Parker said. “We will start next
year [facing further budget cuts]
with absolutely no reserves. .. .
“It was not without some significant
difficulty, when you’re trying to get
people to identify funds,” Parker said
of what the defenders went through
to avoid layoffs. “The effect is we are
covered for this year, but, of course,

the cut carries into next year. Any
additional cut [in the 2008-09 fiscal
year] for anybody will mean either
not filling positions as they vacate
or, depending on the depth of
the cut, terminating employees.”
“We’re starting to run on fumes,”
Eighth Circuit State Attorney William
Cervone, vice president of FPAA.
“We are starting to be at a position
where things are slowing down,
things are not being processed.
In many places, we are starting
to look at what cannot be done.”
The most immediate impact on prosecutors is a reduction in specialty
operations. “I had two attorneys
assigned to serious narcotics cases,”
Cervone said. “I’m down to one, and
it may be none because I cannot afford specialization. These are the first
kinds of things to be raided so you
can keep up with the general work.”
“We are going to have to start to
triage cases and focus on cases
we think are the greatest threat
to public safety,” he said, which
means crimes against persons would
likely take priority over property
crimes. “People are not going to
like that. I don’t blame them. .. .
“We have real concerns about public safety. No one is going to prison if
there is not a prosecutor between the
police and the gates of the prison.”
Prosecutors will also have problems
if public defenders are forced to
make layoffs. Cervone said about
40 percent of defendants are represented by public defenders, and
if those defenders are furloughed, it
will impact state attorneys as well.
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On the State Scene
Reprinted from the February 21, 2008, edition of St. Petersburg Times

Cost-Cutting May Close Courts
Workers may be sent home without pay. A judge calls it a “catastrophe.”
By Jamal Thalji and Colleen Jenkins, Times Staff Writers
Judges across Florida say the state’s budget crunch will
shutter courthouses for weeks this spring as thousands
of court employees are sent home without pay.
At risk, they say, is a halt to all civil litigation for those
weeks, such as foreclosures and divorces. All that would
be heard is priority family law cases and critical criminal
proceedings.
“It’s going to be a catastrophe,” said Hillsborough
County’s Chief Judge Manuel Menendez.
But in Tallahassee, where lawmakers are faced with
making even deeper cuts across state agencies in
the coming year, sympathy is scarce. The court system
had ample warning this was coming and should have
planned accordingly, leaders say.
“If the money’s not there, we can’t spend it,” Sen. Victor
Crist, R-Tampa, said Wednesday, a day after the chief
justice of the Florida Supreme Court asked Crist’s budget
committee to intervene. “And it’s not there.”
It’s Florida’s worsening economy that is pitting the two
branches of government against each other. The Legislature held a special budget-cutting session in October
to cope with a drop in state revenue.
The state court system took a 2 percent hit then. But
Gov. Charlie Crist also ordered state agencies to not
spend 1 percent of their budget each quarter in case
additional cuts were needed.
Sen. Crist, who is not related to the governor, said the
judiciary was asked months ago to voluntarily hold back
4 percent of its budget “in case the money doesn’t
come in.”
Now, it looks like it won’t. A new revenue estimate next
month is expected to show the state’s tax collections
are lower still than what was predicted in the fall.
The state Supreme Court estimates that to absorb a 4
percent cut or $16.9-million, circuit courts would need
to send workers home for 22 days; county courts for
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58 days.
In Pinellas and Pasco it would affect 244 employees; in
Hillsborough that number would be 240. The number
for Hernando County court employees wasn’t available
Wednesday.
“I’m pleading for the life of a branch of government,”
Chief Justice R. Fred Lewis of the Florida Supreme Court
told senators Tuesday as the state’s 20 chief judges
flooded the Capitol for a day of lobbying. “In essence,
you are destroying a branch of government.”
But Sen. Crist said falling state revenue and the judiciary’s “poor fiscal management” are to blame.
Crist said that his Senate Criminal and Civil Justice Appropriations Committee tried to shield judges from the
brunt of budget cuts and that judges were warned
these cuts could be coming.
But Menendez said judges were led to believe that they
would receive a significant chunk of that money back
this spring and spent accordingly to cover salaries.
The chief of the Pinellas-Pasco circuit, Judge Robert
Morris Jr., said the senator is mistaken about another
aspect of those “holdbacks.” Judges were warned to
hold back on costs - not salaries.
Lewis told Crist’s committee Tuesday that salaries make
up 87 percent of the Florida judiciary’s budget. So if the
Legislature wants to cut the judicial budget in the last
quarter of the fiscal year - April, May and June - then
that’s where the money is going to come from.
First, this caveat: Judges’ salaries won’t be affected. The
cost of running court buildings is paid for by counties.
But judges say everyone who helps them do their jobs
will be affected. That means judicial assistants, magistrates and mediators. That means no hearing officers to
handle traffic court or child support hearings, no case

Continued on page 14
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NCRA’S 2008 LEGISLATIVE BOOT CAMP

Realtime Gets a Voice on Capitol Hill: The
Realtime Writers Act
By Susan D. Wasilewski, RPR, CRR, CCP, CMRS, FPR, and NCRA
2008 Legislative Boot Camp Attendee

managers to navigate family court,
even the district courts of appeal will
have to shut down.
“We’re just people,” Morris said.
That’s not what Crist, a Tampa Republican, thinks. He said his staff
calculated the judiciary can cut
that out of the last quarter of this
year’s budget without furloughing
anyone. The money can come
from maintenance, operations and
contracts, Crist said. His committee is
expected to discuss the issue again
in a meeting today.
The senator said the judges’ threat
to furlough state workers “is a ploy
to create a groundswell to oppose
the Legislature.”
Everyone will have to sacrifice,
warned State Senate President Ken
Pruitt.
“I’d rather be furloughed one day
a month and keep my job,” said
the Port St. Lucie Republican, “than
have somebody who’s my workmate lose their job.”
But some jobs, the judges say, are
too important to lose for even a
day.
“They say the wheels of justice turn
slowly,” said Hernando Circuit Judge
Daniel Merritt Sr., chief judge of the
5th Circuit. “This would bring it to a
halt.”
Steve Bousquet, Shannon ColavecchioVan Sickler, John Frank and Jennifer
Liberto contributed to this report. Jamal
Thalji can be reached at thalji@sptimes.
com or 727-869-6236.
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The Telecommunications Act of
1996 established January 1, 2006,
as the deadline for all new Englishlanguage television programming to
be closed captioned. That deadline
was not met due to a shortage of
realtime captioners.
In order to meet the mandates put
on television broadcasters by the
Telecommunications Act, more captioners are needed. The Realtime
Writers Act was written with that goal
in mind. The act, first introduced in
February 2007 by Sen. Thomas Harkin
[D-IA], would provide competitive
grants to court reporting schools
to help them train more captioners
and CART writers. The funding would
enable qualified schools to do such
things as update their curriculums
and equipment, and improve their
marketing, recruiting and job placement efforts.
NCRA’s 2008 Legislative Boot Camp
was conducted to promote this federal initiative on Capitol Hill in Washington, DC. Legislative Boot Camp
is a three-day event attended by
state association leaders and court
reporting educators from across the
country. The first two days consist
of intensive training on lobbying,
politics, the issues surrounding the
act, as well as other important issues
affecting the reporting profession.
The third day of Boot Camp is when
attendees take what they have
learned and meet with members
of Congress and their aides to seek
support for the act.

Have NCRA’s grassroots lobbying
efforts been successful? Initially,
the Realtime Writers Act was a
standalone bill. In November 2007,
another bill, H.R. 4137, the College
Opportunity and Affordability Act
of 2007, was introduced by Rep.
George Miller [D-CA], to amend and
extend the Higher Education Act of
1965, and for other purposes. The
language of the Realtime Writers
Act was included in H.R. 4137. H.R.
4137 has been passed in the House
and now goes to the next stage of
the legislative process, to be considered in conference committee.
This is where the bill may undergo
significant changes in markup sessions before moving over to the
Senate. Hopefully, the language
contained in the Realtime Writers
Act will remain in the Senate version
of the bill and go on to be passed by
the Senate and signed into law by
the President. NCRA will continue
to closely monitor the progress of
the legislation.
Will the passage of H.R. 4137 and
the companion Senate bill mean
the end of NCRA Legislative Boot
Camps? The answer to that question is a resounding no. Our profession faces a litany of difficult issues.
NCRA recently formed coalitions
with other associations to improve
upon legislation affecting small
businesses, independent contractors, and those seeking affordable
healthcare. There is no doubt that
future Boot Camp volunteers will be
called upon to serve NCRA’s membership by donating their time lobbying in Washington to help protect
and promote the court reporting
profession.
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Association Business
Florida Court Reporters Association

PRO BONO PROGRAM
A GUIDE FOR REPORTERS
INTRODUCTION
For several years, studies have uncovered significant
numbers of citizens who have civil legal needs they
cannot pay for. Court reporters around the country
are eager to help guarantee every citizen’s right to
equal justice under the law. To that end, the Florida
Court Reporters Association has established a pro bono
program.
WHY SHOULD I GET INVOLVED IN A PRO BONO PROGRAM?
Here are some possibilities: 1. Sometimes people
need expert help. Reporters are experts who possess
special skills. Your contribution can make a difference
in whether or not someone less fortunate than you gets
a fair shake from the legal system. 2. Pro bono work is
widely recognized as a hallmark of true professionalism.
You can help show that court reporters are responsible
partners in the legal process. 3. You can make useful
contacts in the course of your volunteer work. 4. It feels
good.
I’VE DONE A DEPO HERE AND THERE ON A PRO BONO
BASIS WITHOUT MAKING A BIG DEAL OUT OF IT. WHY
SHOULD I BOTHER WITH THE FORMALITIES OF WORKING
TOGETHER THROUGH A PROGRAM?
First, good for you! But there are a couple of reasons for working through a formal program. First, Bar
programs screen civil pro bono applicants, so you’re
not likely to get burned. Second, working through a
program gives you an “out” if you are approached directly by an attorney about doing a job free of charge.
Third, a formal program gives us a way to track reporter
participation and demonstrate our commitment.
WHAT ARE REPORTERS OFFERING IN THE WAY OF PRO
BONO SERVICES?
The main reason for involving a reporter in any
matter, of course, is to obtain an accurate record of
a proceeding. In times past, a pro bono lawyer might
have had to forego conducting depositions that would
have been useful to his or her case because there
was no money to pay for them. With reporters willing
to contribute services at waived or reduced fees, pro
bono attorneys have an added tool at their disposal
to effectively pursue the cause of justice.
FCRA encourages reporters to volunteer whatever
they feel comfortable contributing — a couple of hours
a year, 50 transcript pages, waiver of appearance fee,
or whatever. In any case, it is important for the reporter
and the attorney involved in a particular case to know
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what the reporter will be contributing so that no misunderstandings occur.
HOW CAN I BE SURE A LITIGANT IS TRULY INDIGENT?
FCRA encourages reporters to work only with established pro bono programs. Bar pro bono programs
conduct thorough reviews of applicants to make sure
they, in fact, qualify under the program’s guidelines.
After all, lawyers who contribute time and expertise do
not like to be taken advantage of.
HOW OFTEN WILL I BE ASKED TO REPORT A PRO BONO
PROCEEDING?
In general, you as a volunteer are in control of how
much you choose to contribute. It’s unlikely you will be
asked to participate more than once a year. Encouraging your colleagues to participate is an effective way
of ensuring the load is equally shared.
WHAT IF I RUN INTO A PROBLEM DURING A PRO BONO
DEPOSITION?
Handle problems as you normally would. Then
immediately report the matter to your pro bono coordinator.
WHAT HAPPENS WHEN ONE PARTY IS INDIGENT AND THE
OTHER IS NOT?
You can charge normally for services provided to
the non-indigent party.
IT ALL SOUNDS GOOD TO ME. WHERE DO I SIGN UP?
1. Fill out and return the pledge card.
2. Contact FCRA Headquarters at 222 S. Westmonte Drive, Suite 101, Altamonte Springs, Florida,
32714.
3. Contact the Pro Bono Coordinator, Deanna
Boenau, americaption@comcast.net.
POINTS TO REMEMBER:
1. Work only through established pro bono programs.
2. CIVIL CASES ONLY.
3. Give only what you feel comfortable with and
encourage colleagues to participate.
4. Fill out and return the evaluation form so that
records may be maintained and credit given.
YOUR STATE COORDINATOR IS: Deanna Boenau, RDR,
CRR, CBC, CCP, AmeriCaption, Inc., P.O. Box 50653,
Sarasota, FL 34232, 941-359-8100 (office), americaption@comcast.net.
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Association Business
Florida Court Reporters Association

PRO BONO PROGRAM
REPORTER PLEDGE CARD
I am interested in participating in the Pro Bono Program and am willing to donate:
Attendance Fee

___________________ hours

Transcript at No Charge

__________________ pages

Transcript at a Reduced Rate

$______________ per page

Transcript at the Regular Rate

$______________ per page

___________________________________________________________________________________________________________
___________________________________________________________________________________________________________
___________________________________________________________________________________________________________
________
________

I am willing to donate my services on a case-by-case basis.
I am willing to provide reporting for:

		 ____ Depositions

____ Hearings

____ Trials

I will need advance notice of _____ days.
REPORTER’S NAME__________________________________________________________________________________________
MAILING ADDRESS__________________________________________________________________________________________
CITY/STATE/ZIP _____________________________________________________________________________________________
E-MAIL _ _________________________________________________ CELL #____________________________________________
HOME # ________________________________________________WORK #____________________________________________
_______ Individual Donations

_______ Firm Donations

Geographical area you are willing to serve:
___________________________________________________________________________________________________________
___________________________________________________________________________________________________________
___________________________________________________________________________________________________________
PLEASE MAIL THIS FORM TO:
DEANNA BOENAU, RDR, CRR, CBC, CCP, P.O. Box 50653, SARASOTA, FL 34232.
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Association Business
Florida Court Reporters Association

PRO BONO PROGRAM
REPORTER ASSIGNMENT/EVALUATION
REPORTER’S NAME _________________________________________________________________________________________
ADDRESS _ ________________________________________________________________________________________________
CITY/STATE/ZIP______________________________________________________________________________________________
E-MAIL___________________________________________________ CELL #____________________________________________
HOME # ________________________________________________WORK # ___________________________________________
ASSIGNMENT _ _____________________________________________________________________________________________
___________________________________________________________________________________________________________
___________________________________________________________________________________________________________
(Cancellations will be made directly by the attorney’s office)
REPORTER’S EVAULATION
Hours in attendance fee donated

___________________________

Pages provided at no cost

___________________________

Pages provided at reduced rate

___________________________

Pages provided at regular rate

___________________________

Other services provided __________________________________________________________________________________
__________________________________________________________________________________________________________
__________________________________________________________________________________________________________
Had I invoiced this job, the total fee would have been

$ __________________________

DATE:______________________________________________________________________________________________________
COMMENTS:________________________________________________________________________________________________
___________________________________________________________________________________________________________
___________________________________________________________________________________________________________
PLEASE MAIL THIS FORM TO:
DEANNA BOENAU, RDR, CRR, CBC, CCP, P.O. Box 50653, SARASOTA, FL 34232.
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CALL FOR NOMINATIONS
As provided for in the Bylaws, the immediate past president of FCRA serves as chair of the Nominating Committee. The president
appoints four additional members to the committee and two alternates who serve in the event of absences of committee
members. The committee will meet in June at the Mid-Year Conference to draw up a slate of nominees for the following
positions on the Association Board of Directors to be elected at the 2008 Annual Convention:
Qualifications and qualities to look for in potential FCRA officers and directors:
ADMINISTRATIVE TRAITS:

LEADERSHIP:
•
•
•
•
•
•

Interest, concern, conviction,
dedication
Decision making capabilities
Objectivity
Knowledge and experience
Reliability
Ability to inspire

•
•
•
•

Courtesy
Humility
Friendliness
Tact and diplomacy

ABILITY:
•
•
•
•
•

Communication skills
Initiative
Professional image
Maturity
Association experience

The committee hopes you will consider it your personal responsibility to participate in the nominating procedure
by submitting names of potential candidates for consideration by the Nominating Committee. Take this chance
and participate in their selection. Send, fax or e-mail the names of your recommended candidates to Cathy
Phillips, 814 E. Silver Springs Blvd., Ste. A, Ocala, Florida 34470. Fax 352-368-2562 or e-mail cjphillips111@aol.com.
Please submit nominations no later than May 23, 2008.
r
r
r
r

President-Elect (one-year term)
Vice President (one-year term)
Secretary (one-year term)
One Director-at-Large (one-year term)

r
r
r

Treasurer (one-year term)
Northern Director (two-year term)
Southern Director (two-year term)

I recommend the following FCRA member for consideration as a potential candidate for the position of:
___________________________________________________________________________________________________________
Name:_____________________________________________________________________________________________________
I support the candidate for the following reasons: ___________________________________________________________
___________________________________________________________________________________________________________
___________________________________________________________________________________________________________
___________________________________________________________________________________________________________
May the Nominating Committee contact you by phone/e-mail if further information is needed about the
candidate? r Yes r No
Office Phone:_____________________________________ Home Phone:____________________________________________
Email Address:_______________________________________ Cell Phone:____________________________________________
Signed (FCRA member): __________________________________ Date:____________________________________________

Submit nominations no later than May 23, 2008.
Please photocopy this form for additional potential candidate
recommendations or provide on a separate sheet.
18
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• wanted •
Your old FSRA/FCRA magazines! Any vintage
needed, but especially the older ones, ‘70s (or even
‘60s!) Please contact Donna Kanabay re: FCRA
History Project by e-mail donna@kanabay.com or
cell: 813 545 0645. (If you have something we need,
we promise we’ll return it to you after scanning!)

Of Course You Waited, Now it’s Time to Move.
(Come see SmartCAT for Windows w/Bonus features... but only if you want to use them)

w w w. c h e e t a h i n t e r n a t i o n a l . c o m
May/June/July 2008 • FCR Online

•

1.877.333.2287
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FCRA Spotlights
By Ginny Hyland and Gayl Hardeman, Convention
Planning Co-Chairs

2008 Mid-Year Conference
June 27-29, 2008 • SARASOTA HYATT HOTEL • “POSSIBILITIES!”
A GREAT Convention Planning
Committee has planned for you a
weekend you will LOVE. You’ll come
away saying, “I didn’t know that was
POSSIBLE!”
Something for everyone – REPORTERS, FIRM OWNERS, STUDENTS!
Learn new COMPUTER SHORTCUTS
FOR EVERYONE! - Nancy Paulsen,
RPR, a fearless computer “geek”
shows you some very cool tricks!
Learn how to buy and sell EVERYTHING on eBay - Sarasota Scire
Brothers, who’ve mastered the
MYSTERY!
Learn from a dynamic speaker how
to improve your personal and professional RELATIONSHIPS! - Jill Obrochta, host of TV/Radio show, “What
Every Woman Wants” http://www.
whateverywomanwants.tv/
STENO SWAP Workshop! Send in
your favorite five steno briefs — and
MOST WANTED briefs — with your

registration, and you’ll take home
a master list! - Traci Dedrick, RPR,
Moderator
Gayl Hardeman’s five most favorite
steno briefs:
R-FP for “research”
HR-FP for “literature”
GRIFM for “algorithm”
POURPT for “PowerPoint”
KPOENT for “component”
Gayl’s MOST WANTED brief – Got a
good one for “so to speak?”
VIDEO POSSIBILITIES –How your
videographer can help you hear
perfectly, and other NEW TECH possibilities! - LaJuana Pruitt, CLVS
A workshop on Cyber Storage
especially geared for Firm Owners – a safe program that allows
you to store an entire firm’s notes,
transcripts, and videos, with easy
indexing, logging and retrieving features – highly recommended by Firm
Owner Ginny Hyland! - Jonathan
Elliott, the program’s creator

VENDOR BREAKOUT SESSIONS!
YOGA: Benefits and Practice –
Saturday night before the party
come relax on a mat or towel and
learn some stretches ESPECIALLY
DESIGNED FOR COURT REPORTERS.
Feel the tension leaving your neck
and shoulders and back. Mabel’s
comforting style and instruction will
amaze you with the POSSIBILITIES of
Yoga! - Mabel Smith, Certified Yoga
Instructor
Saturday night - “FLORIDA’S GOT
TALENT” – Pay to have someone sing,
dance or perform (select from 50
talents!), or Pay to PASS. A great, fun
time to laugh, relax and reconnect
with your fellow reporters.
FIRST EVER FIRM OWNERS NETWORKING BREAKFAST – SUNDAY A.M.!

Congratulations...You Did It!
Congratulations to the following reporters from around the State of Florida who became
certified as a result of the January 2008 RPR, RMR, RDR, CBC and CCP written knowledge
tests:
Registered Merit Reporter (RMR)
Denise Sankary, West Palm Beach, FL
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FCRA FUNDRAISING
DRAWING

Choose a Cruise (or cash)

A Note of
Appreciation

Tickets are on sale now for an 8-day, 7-night cruise for
two. And, unlike other drawings, only 100 tickets will be
sold. You get to pick a cruise departing from Miami or
Port Canaveral on Royal Caribbean. For just $50 a ticket
you get the chance of winning a great getaway for
two on the open water of the Caribbean, stopping to
see the sites at the numerous ports of call.

Editor’s Note: It is not often that the staff and Board of
FCRA receive an encouraging note thanking them for
the work they all do for our association and how valuable FCRA’s services are to our members. On January
30, 2008, I received this e-mail from Linda Dyer, FCRA
Past President. I would like to now share it with all of
our readers.

If you choose to depart from Port Canaveral, you first
will head to Nassau, then to St. Thomas and finally St.
Maarten.

Hi, Louise.

Your other option takes you from Miami to Labadee,
Hispaniola; then to Ocho Rios, Jamaica; on to Georgetown, Grand Cayman, and finally Cozumel, Mexico; or
to CocoCay, Bahamas; then to Chalotte Amalie, St.
Thomas; and finally to Philipsburg, St. Maarteen.
The winner will receive the cruise and $500 in spending
money. Or, you can just take the cash instead, $2500.
As stated above, this drawing will be limited to 100 tickets being sold. So don’t delay, order yours now while
the odds are in your favor. Just email Sandy Narup at
snarup@bellsouth.net to get your ticket or contact any
one of the FCRA board members. You can also just
send your check made out to FCRA to Sandy Narup,
725 Hunt Club Trail, Port Orange, FL, 32127.
The drawing will be held at the Mid-Year Conference
in Sarasota on June 28, 2008. You do not have to be
present to win.

I just read the latest issue of FCR Online, and I am reminded once again how valuable membership in FCRA
is, especially the “magazine.” The articles you publish
on ethics, professionalism and the Mr. Modem columns
are excellent.
Your recent articles in the On The Job section, StandBy No-Show Certificates and Non-Party Request for
Transcript Sample Letter, are worth the price of membership. If members read these articles and follow the
guidelines set forth therein, they ostensibly will stay out
of trouble and save themselves much more than the
cost of membership — a potential lawsuit and/or loss
of a client, or worse.
You and the staff and Board of FCRA continue a legacy
of excellence started many, many years ago here in
Florida — even before my time. Congratulations and
my personal thanks for all you do.
Linda Dyer, Past President
MJC REPORTING, INC.
lindamdyer@yahoo.com

Bon Voyage!!!!
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On the Job

Create Your Own Newspaper
Q. I’m a news junkie and though many sites permit
me to customize the type of news I want, I was
wondering if there is any way to pull together news
from various sources so I can just go to one place
and see my favorite news items?
A. One of the oldest news sites on the Web is one that
does permit you to do that in a clever way, and for
free. The site is called CRAYON (www.crayon.net).
The name is an acronym derived from CReAte Your
Own Newspaper. After registering on the site, go
to Your Paper’s Settings where you can name your
publication, give it a motto, select the page layout,
graphics, and then select your news sources from
a vast array of publications, news media, by topic
or other criteria. Once you’ve made and saved all
your selections, log-in and click “Read My Paper.”
It will be assembled and presented to you faster
than you can holler, “Extry! Extry! Read all about it!”
If you’re a news junkie, be sure to check out www.
newser.com, also.
Q. When I click View > Details in a folder, is there any
way I can keep that view so I don’t have to reselect the Details view again with the next folder?
A. Theoretically, Windows will remember the View
selected for each folder and will display it the same
way each time the folder is opened. The operative
word in the previous sentence is “theoretically.”
Sometimes Windows remembers, sometimes
Windows doesn’t. I can relate.
You can encourage Windows to remember your
View settings by first configuring a folder the way
you want it to appear. Then, go to the Control
Panel > Folder Options > View tab. For versions of
Windows prior to XP, look at the list of options in the
Advanced Settings section and locate “Remember
each folder’s view Settings.” Click to place a check
mark in front of this option, then click Apply > OK
to save and exit. XP users, click the “Apply to All
Folders” button, followed by Apply > OK.
Vista users, go to the Control Panel > Appearance
and Personalization > Folder Options > View tab
and click the “Apply to Folders” button. A less click-
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intensive method with Vista is to click the Start
button and in the “Start Search” field, type “folder
options.” Click Folder Options when it appears as
a search result and you’ll be transported to the
Folder Options dialog box.
Q. I’m divorced, but my married name appears in the
From: field of email that I send using Outlook. I
can’t figure out how to change the name people
see when I send messages. Can you help, Mr. M?
A. You can easily change the name that identifies
you as the sender. The process is the same for
both Outlook and Outlook Express: Click Tools >
Accounts > Mail tab. If you have more than one
email address, you will see them displayed in a
list. If you only have one, it will be the only one
displayed. (When it comes to stating the obvious,
you can count on Mr. Modem.)
Click to select the account you want to change,
then click the Properties button. The current name
displayed on your email will appear in the Name:
field, which you can edit to reflect your new name
— or old name, as the case may be. When you’re
finished, click Apply > OK to save your changes.

Have You
Visited FCRA’s
Website?
For all your court
reporting needs...
www.fcraonline.org
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Mr. Modem’s
Don’t Miss
‘em (DME)
Sites of the
Month

The American Roadside: This
site is bumper-to-bumper full of
entertaining roadside attractions,
interesting
destinations
along
scenic routes, and wonderful old
“meat-loaf-and-taters”
diners.
Read articles, view the photo
gallery, or buy books, t-shirts,
and other American Roadside
paraphernalia, all destined to
end up in your junk drawer. www.
theamericanroadside.com
About Big Numbers: Have you ever
wondered how big an octovigintillion
is? How about a tredecillion, or a
quattuordecillion, or a million-jillion,
or perhaps a penicillin? There are
so many big numbers here that
you’ll have a splitting headache in
no time. http://tinyurl.com/yslq65

Brain Training: BrainMetrix advises us
that when it comes to our neurons,
“use ‘em or lose ‘em.” To help
keep the ol’ brain cells stimulated,
BrainMetrix provides an assortment
of cerebral games and exercises
that will keep our minds sharp for…
for… well, perhaps it’s too late for
me, but hopefully it won’t be for you.
Give your gray matter a vigorous
workout by participating in any of
a number of these mind-training
exercises. http://brainmetrix.com
Mr. Modem’s weekly newsletter delivers
helpful computer tips, great Web sites and
his personal answers to your questions! Trial
offer: Subscribe online using Promo Code
1146 and receive one free month with
your 6-month subscription (28 issues!) To
view a sample issue or subscribe, visit www.
MrModem.com.

Sleuthing the Net: A New Threat Or More Hysteria?
By Donna M. Kanabay Harvey. RMR, CRR, FPR
You should know by now that I view
e-mails regarding the latest virus
“threat” with more than a jaundiced
eye, and in the past I hope I’ve
shown that 99% of them are bogus.
I always check www.snopes.com
when I receive one and usually forward the results to the sender with a
strong suggestion that they check it
out themselves before they… forgive
me! … “PASS THIS ALONG TO EVERYBODY IN YOUR ADDRESS BOOK!!!!!!”
One of the points I always make
is that if the threat were real, we
would have heard about it in the
mainstream press.
Well, here’s one that appeared not
only in the mainstream press, but
even a cursory search has the subject cropping up on numerous sites,
including PC World Magazine’s Web
site, as well as many news outlets.
The headline in my March 18 St.
Petersburg Times was, “Your New
Gadget May Carry A Virus.” It’s from
the Associated Press.
“From iPods to navigation systems,
some of today’s hottest gadgets are
landing on store shelves with some
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unwanted extras from the factory —
pre-installed viruses that steal passwords, open doors for hackers, and
make computers spew spam.
“Recent cases include some of the
most widely used tech devices:
Apple iPods, digital picture frames
sold by Target and Best Buy stores,
and TomTom navigation gear.
“In most cases, Chinese factories
— where many companies have
turned to keep prices low — are
the source.”
The article goes on to say that it appears, at least so far, that the problem is from lax quality control rather
than organized sabotage. A careless worker plugging an infected
player into a factory computer for
testing, and then the virus spreads as
more devices are plugged into the
same computer. Security experts
believe that it’s happening at the
tail end of manufacturing, when
devices are pulled from the line for
testing. It’s possible that it’s happening even when a worker plugs his
own infected device into a factory
computer, perhaps to charge it.

“It’s the digital equivalent of the
recent series of tainted products
traced to China, including toxic
toothpaste, poisonous pet food and
toy trains coated in lead paint.”
Of course, the question of how it
could be done deliberately is discussed, and that if that’s the case,
the virus could be much more widespread than anticipated. And due
to corporate secrecy, it’s impossible
to track the problem or even to
quantify it.
The article tells us of a fellow who
bought a digital picture frame
at Target for $50, and when he
plugged it into his computer, his antivirus alerted him to four viruses trying
to upload from the device. Another
digital picture frame, purchased at
Sam’s, contained a virus that not
only steals online gaming passwords,
but disables antivirus software. An
IT specialist reports that his digital
picture frame carried the nastiest
virus he’s encountered in 20 years
in the field.
Continued on page 25
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By FCRA ETHICS COMMITTEE, 2007-2008 Members Chair: Shirley P. King, RPR, CLVS, FPR - Shirley.king@kingreporting.com;Judy Everman, FAPR, RPR, CMRS, FPR - judyeverman@comcast.net ;Louise K. Johnson, RMR, CRR, FPR –
wezi@bellsouth.net;Donna Kanabay Harvey, RMR, CRR, FPR – donna@kanabay.com; Kathy Marino, RMR, CLVS,
CRI, CPE, FPR – kpmarino111@aol.com ; Sandy Narup, RPR, FPR – snarup@bellsouth.net
A CERTIFICATE OF REPORTER FORMAT REVIEW
Since the publication of our new and updated manual, the Committee has noticed there are still many of you
using an outdated Certificate of Reporter format. We have excerpted the following page from your Florida
Manual. Please note that in each instance we have included the authority by which elements are included in
the Certificate. We hope this helps you and you will decide to update your own format.
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Sleuthing the Net: A New Threat
Or More Hysteria?

When Grandma
Goes To Court

Continued from page 23
While it’s believed, for now, that the
infections are not deliberate, they
certainly can point to an avenue
of attack for malicious hackers with
access to the factory equipment. It’s
expected that the problem is going
to become more widespread.
“Monitoring suppliers in China and
elsewhere is expensive, and cuts
into the savings of outsourcing. But
it’s what U.S. companies must do to
prevent poisoning on the assembly
line, said Yossi Sheffi, a professor at
the Massachusetts Institute of Technology specializing in supply chain
management.
‘It’s exactly the
same thing, whether it happened
in cyberspace or software or lead
paint or toothpaste or dog food —
they’re all quality control issues.’”
When the AP contacted some of the
world’s largest electronics manufacturers, most declined to comment
or did not respond. Those who did
reply regarding confirmed infections indicated that the problem
had been corrected and they’ve
incorporated procedures to prevent
it from happening again.
“Apple disclosed the most information, saying the virus that infected
a small number of video iPods in
2006 came from a PC used to test
compatibility with the gadget’s
software.
Best Buy, the biggest
consumer electronics outlet in the
U.S., said it pulled its affected Chinamade frames from the shelves and
took “corrective action” against its
vendor. But the company declined
repeated requests to provide details.
Sam’s Club and Target say they are
investigating complaints but have
not been able to verify their frames
were contaminated.”
You can locate multiple reports
and the entire article by Googling
“Associated Press virus gadgets.”
One discussion covered the gamut
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from the conspiracy theory (that the
Chinese are doing it deliberately,
perhaps with the knowledge and
encouragement of the Chinese
government) to one very good
point that the issue may be more in
the driver disk that comes with your
device than in the device itself.
On the lighter side, I noted one
of the hits was the CNN web site,
so I went directly to their site and
searched “gadgets virus.” That took
me down an interesting side path,
as the first thing that came up was
“Plug ‘N Play USB Virus makes MacBook Fall to Pieces.” You click on
that link and you can then view a
video that is clearly a gag. At least
I think it’s a gag. I hope it’s a gag.
(It’s got to be a gag, right?) Very
funny, at least to somebody like
me. And the comment below it on
the blog made this side trip worth
the time: “Damn that Apple. Even
their virii are better than Microsoft’s.”
(And my favorite comment from this
site: Vista is still the best Plug’n’Play
virus.)
(Five minutes later…) Okay, I may
well have to think about migrating to
Apple, at least for fun. Further discussion on the blog indicates that it may
well not be a gag. You have to see
this to believe it, so I’m not going to
spoil it by trying to describe it!
But seriously, the entire article from
the AP is out there on many sites,
easily located with a simple Google,
along with some discussion about
the level of threat posed. But it’s at
least been clearly documented at
this point that digital picture frames
have, in several instances, been
carrying some nasties. So if just ONE
person reads this and is alerted
and protected from disaster, my
work here is done. This is definitely
something we’ll all need to watch
as it evolves!

Lawyers should never ask a Mississippi grandma a question if they
aren’t prepared for the answer.
In a trial, a Southern small-town prosecuting attorney called his first witness, a grandmotherly, elderly woman to the stand. He approached
her and asked, ‘Mrs. Jones, do you
know me?’ She responded, ‘Why,
yes, I do know you, Mr. Williams.
I’ve known you since you were a
boy, and frankly, you’ve been a
big disappointment to me. You lie,
you cheat on your wife, and you
manipulate people and talk about
them behind their backs. You think
you’re a big shot when you haven’t
the brains to realize you’ll never
amount to anything more than a
two-bit paper pusher. Yes, I know you.’
The lawyer was stunned. Not knowing
what else to do, he pointed across
the room and asked, ‘Mrs. Jones, do
you know the defense attorney?’
She again replied, ‘Why yes, I do.
I’ve known Mr. Bradley since he was
a youngster, too. He’s lazy, bigoted,
and he has a drinking problem. He
can’t build a normal relationship with
anyone, and his law practice is one
of the worst in the entire state. Not
to mention he cheated on his wife
with three different women. One of
them was your wife. Yes, I know him.’
The defense attorney nearly died.
The judge asked both counselors to
approach the bench and, in a very
quiet voice, said, ‘If either of you idiots asks her if she knows me, I’ll send
you both to the electric chair.’
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MEMBERSHIP APPLICATION
Florida Court Reporters Association

Name (Please print) _________________________________________________________________________________________________
Company __________________________________________________________________________________ r

Owner r Co-owner

Mailing Address _____________________________________________________________________________________________________
City/State/Zip _______________________________________________________________________________________________________
Telephone: Home (____) __________________ Office (_____) ____________________ FAX (_____) ___________________________
CHECK ONE: r OK to publish home phone number in directory.

r DO NOT publish home phone number!

E-mail address: ____________________________________________________________________________________________________________________
METHOD OF REPORTING:

r

TYPE OF REPORTER:

r Freelance r Official

Stenographic

r

Voicewriter

r

r Deputy Official

DESIG: r CSR [List State(s) other than FL]___________________

p

PARTICIPATING MEMBER ..............................................................$115.00
Open to anyone engaged in active practice of official or general
court reporting by either stenographic or voicewriter method. (Please
indicate method above.)

p

STUDENT MEMBER ...........................................................................$35.00
Open to any student of shorthand reporting who is endorsed by a
court reporting training program instructor or director.

p

RETIRED MEMBER ............................................................................$45.00
Open to any participating member in good standing who has retired
from the active practice of shorthand reporting.

p

ASSOCIATE MEMBER .................................................................... $60.00
Open to the following: teachers of shorthand or shorthand reporting, anyone officially connected with a school or college conducting a shorthand
reporting course, any non-member retired from active shorthand reporting, anyone professionally associated with or employed by a member of
FCRA whose application is endorsed by a participating member in good
standing, and anyone qualifying for Participating membership, but residing
outside of Florida.
VENDOR MEMBER.........................................................................$125.00
Open to any firm or corporation engaged in selling products or services
to FCRA members.

PRO BONO: Are you interested in donating time to the Pro Bono Program?
p Yes p No
FLORIDA MANUAL: The guide to court reporting in Florida — sample forms,
guidelines, and rules of court. Cost for members: $35.00. Subscription to
updates: $10.00.
MEMBERSHIP DIRECTORY: Geographical and alphabetical listing of members
on disk or via email. Cost to members: $10.00.
LEGISLATIVE/LEGAL FUND: Your dues include only regular monitoring of
legislative, regulatory, and administrative activity for things that could adversely affect the court reporting profession. Without member donations to
this fund, the Association cannot pursue any legislative/legal activity and
may not be able to protect our profession.
The dues year is November 1 through October 31. Annual dues must accompany application. Those joining in August, September, or October of a given
year will be paid through October 31 of the following year. Dues payments
are deductible by members as an ordinary and necessary business expense.
In accordance with Section 6033(e)(2)(A) of the Internal Revenue Code,
as amended, members of the FCRA are hereby notified that an estimated
5% of your FCRA dues will be allocated to lobbying and political activities,
and therefore are not deductible as a business expense.

For Administrative Use Only
Date Rec'd __________
Amount
__________

Check #
Computer

__________
__________

r

r Federal

Pittman r

Other _________________________________

r Teacher

r Student

r Other _______________

r FAPR r FPR r RPR r RDR r CMRS r RMR r CLVS r CRI r CRR r CPE

I make application for Membership as a: (CHECK ONE)

p

Gregg

I hereby make application for membership in the Florida Court Reporters
Association and pledge myself, if accepted, to abide by the requirements
of the Bylaws and Code of Professional Responsibility of the Association
as they are now and as they may be amended in the future.
My signature below constitutes my consent to receive faxes, email, and
other communications from FCRA or on behalf of FCRA.
______________________________________________________________
Signature of Applicant
Date
______________________________________________________________
Signature of Sponsor
______________________________________________________________
Name of Sponsor (Please print or type)

PAYMENT ENCLOSED FOR:
Membership Dues

$ ______________

Florida Manual on disk:
__ copies @ $35.00 each
(Includes 7% sales tax + handling)

______________

One-year subscription
to Florida Manual Updates
__ subscriptions @ $10.00 each
(Includes 7% sales tax + handling)

______________

Membership Directory on Disk:
__ copies @ $10.00 each
(Includes 7% sales tax + handling)

______________

Legislative/Legal Fund Donation:

+ $25.00
______________

TOTAL ENCLOSED:

$__________

r Check r MasterCard r VISA r AmEx Exp. Date________
Account # __________________________________________________
3- or 4-digit Security Code:___________________________________
Amount to charge: $ _______________________________________
Authorized Signature ________________________________________

Make check payable to FCRA and mail to FCRA Headquarters, 222 S. Westmonte Dr, Ste 101, Altamonte Springs, FL 32714
Telephone 407-774-7880 • FAX 407-774-6440 (for charge payments only) • www.fcraonline.org

FCRA welcomes the
following new members
(Includes all members who joined as of April 12, 2008)

PARTICIPATING MEMBERS
NAME

CITY

SPONSOR

Jacqueline Hillman..................................................... Fort Myers...............................................................Thomas Hughes
Julie Kelley................................................................... Kissimmee...............................................................Thomas Hughes
Melinda McKenna.........................................................Tampa..................................................................Thomas Hughes
Teresa Sapp................................................................. Fort Myers...............................................................Thomas Hughes
Kimberly Westberry..................................................... Fort Myers...............................................................Thomas Hughes

STUDENT MEMBERS
Pamela Brennan....................................................... Jacksonville..............................................................Thomas Hughes
Cicely Clements........................................................ Jacksonville..............................................................Thomas Hughes
http://en.wikipedia.org/wiki/Stephen_Hawking
Leanne
Fitzgerald.....................................................St. Augustine.............................................................Thomas Hughes

Quote of the Day
Stephen

Hawking

“I think computer viruses should
count as life. I think it says something
about human nature that the only
form of life we have created so far
is purely destructive. We’ve created
life in our own image.”
Stephen William Hawking

Stephen Hawking
English cosmologist and physicist (1942 - )

Born

January 8, 1942
Oxford, England

Residence

United Kingdom

Nationality

British

Fields

Applied Mathematics and Theoretical
Physics

Institutions

University of Cambridge

Alma mater
University of Oxford
May/June/July
2008
University of Cambridge
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Across Tampa Bay and Across Florida
Your Client!
Your Reporter!

or

Your Client
Our Reporter

in our offices!
All the questions they can ask…
All the candy you can eat…
Such a Sweet Deal!
The concept is simple: Why not share resources among reporting firms, to everybody’s
benefit? Given the critical reporter shortage, and the expense of maintaining multiple
locations, we all need each other!
Bring your own client to one of our strategically located offices and pay a reasonable fee for
the full use of the offices and all our amenities and courtesy supplies. Or, send your client to us:
We’ll take good care of them and pay you a reasonable percentage for the referral!
All locations are private offices; the space leased only by our firm.
No shared suites or other tenants using the space, services, or equipment.
Our flagship office is located on the concourse level of

Tampa International Airport

Other offices:
Feather Sound Square,* Clearwater

15 mins from Tampa International Airport
*videoconferencing at this location

Downtown St. Petersburg

Next door to the Judicial Bldg.

Kanabay Court Reporters; Tampa, St. Petersburg, Clearwater
PO Box 178; St. Petersburg, FL
(727) 821-3320
Fax: (727) 898-5701
Tampa Line: (813) 224-9500
www.kanabay.com
e-mail: dmkh@kanabay.com
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fcra west palm collier lee reporters wanted.doc

Reporters Referral Network
1
2
3
4
5
6
7

Registered Professional Reporters
Certified Legal Video Specialists
Certified Real Time Reporters
Corporate Headquarters
14 Suntree Place, Suite 101
Melbourne/Viera, Florida
Deposition Suites Available at:
VIERA, MELBOURNE, TITUSVILLE, ROCKLEDGE, MAITLAND
WORLDWIDE VIDEO CONFERENCE SUITES
available at Corporate Office
Electronic White Board
Document Camera
LCD Projector
DVD or VHS
Toll-Free: (800) 892-1742
Voice: (321) 242-8080
Fax: (321) 242-8088

915 Chestnut Street •
Clearwater, FL 33756

*with this ad

8
10
11
12
13
14
15
16
17
18

PALM BEACH,
COLLIER, LEE,
Broward, and
Miami-Dade counties

All income
guaranteed!

9

We offer:
9
9
9
9
9
9

Great jobs with great pay
Presitigious clients
Direct deposit
Biweekly pay
Training in the latest technologies
Access to group benefits

19
20
21
22
23
24
25

D&D Reporting
Service

$2000*
Sign-On
Bonus

Immediate openings for
quality reporters in

For further information, e-mail
benowitz@gate.net or fax your resume to
(305) 376-8833

Classifieds
SOUTH FLORIDA — Experienced reporters and realtime
reporters needed in Dade/Broward/Palm Beach Counties.
Will train qualified beginners. $1000 sign-on bonus!
Great earnings opportunity. We pay twice a month for
everything billed. Contact Brian at Kaplan LaCour &
Associates (305) 740-7121, fax (305) 740-7140, or email
blacour@kaplanlacour.com. (4/4)

Busy Tampa Bay court reporting
company looking for court reporter
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hearings and trials. Work based on
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